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RX600シリーズ 
RPDLおよび PDGの使い方 

要旨 
ルネサス周辺ドライバライブラリ（RPDL）はルネサスマイクロコントローラ上で周辺モジュールを設定お
よび制御するための統合 APIです。サポートされている周辺機能としては、タイマ、ウォッチドッグタイマ、
DMA、DTC、SPI、I2C、ADコンバータおよび DAコンバータなどがあります。下図に示すように、RPDLは
ユーザアプリケーションと対象MCUの間にあるソフトウェア抽象化層です。RPDLは対象MCU上でサポー
トされる周辺機能レジスタのすべての読み出しと書き込みを処理します。RPDLはほとんどの周辺機能をサ
ポートしていますが、USB、イーサネット、CANなどのより複雑な周辺機能はサポートしていないので、使
用するには独自のドライバが必要です。これらのドライバによって RPDLを自由に使用することができます。 

ユーザアプリケーション関数呼び出し

ルネサス周辺ドライバライブラリ（RPDL） ドライバを含むミドルウェア

CPU USB、イーサネットまたは
CANRPDLによってサポートされる周辺機能

対象MCU  

図 ソフトウェア層を持つ MCU 

Peripheral Driver Generator（PDG）は PC上で動作するグラフィカルツールで、RPDL関数呼び出しを生成し
ます。PDGは使いやすいグラフィカルインタフェースを通じて対象デバイスの周辺機能を構成する機能を
ユーザに提供します。ユーザが周辺機能を PDGに構成すると、周辺機能はコードを生成することができ、PDG
はこれらのファイルを HEWプロジェクトに自動的に組み込みます。 

このアプリケーションノートでは、RPDLの使い方と PDGによって付加される効果について説明します。
最初に RPDLを使用して HEWで周辺機能のサポートを手動で実装する実例を示し、その後、PDGを介して
同じサポートを生成する簡単な方法を示します。 

 

動作確認デバイス 
YRDKRX62N 
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1. 必要なツール 
このアプリケーションノートは YRDKRX62Nプラットフォームを対象として作成されていますが、RPDL
と PDGを使用する基本的な手順はどのようなプロジェクトにも適用することができます。 

この手順を実行する前に、以下のものをインストールしてください。 

• RX62N RDK DVD 
http://am.renesas.com/products/tools/introductory_evaluation_tools/renesas_demo_kits/yrdkrx62n/child_folder/dow
nloads_child.jsp 

• Peripheral Driver Generator バージョン 2 
http://www.renesas.com/pdg_download 

 
本書で参照される、RPDLを含むその他のコードは、このアプリケーションノートに同梱されている'Source'
ディレクトリに収められています。 
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2. RPDLワークスペースの作成 
本章では、RPDLで使用するワークスペースのセットアップについて説明します。 

 

手順： 
ステップ 2.1 Start ⇒ All Programs ⇒ Renesas ⇒ High Performance Embedded Workshop ⇒ High Performance 

Embedded Workshopの順に選択して HEWを起動します。 

ステップ 2.2 Welcomeウィンドウで、"Create a new project workspace"を選択して、"OK"をクリックしま
す。 

ステップ 2.3 "CPU family"ドロップダウンから"RX"を選択します。 

ステップ 2.4 "Tool chain"ドロップダウンから"Renesas RX Standard"を選択します。 

ステップ 2.5 "Project Types"の下のエントリから"Application"を選択します。 

ステップ 2.6 "Workspace Name"フィールドに"RX_RPDL_Demo"を入力します。ウィンドウは図 2.1のよ
うになります。"OK"をクリックします。 

 
図 2.1 新しいワークスペースの作成 

 
ステップ 2.7 ウィンドウ内で、"CPU Type"の下にあるリストから"RX62N"を選択します。"Next"をク

リックします。 

ステップ 2.8 タイトルバーに"New Project-3/10..."と表示されるウィンドウが出るまで"Next"をクリック
します。このウィンドウで、"Changes code generation"ドロップダウンボックスから"None"
を選択します。 

ステップ 2.9 タイトルバーに"New Project-4/10..." と表示されるウィンドウ（図 2.2）が出るまで"Next"
をクリックします。"I/O Register Definition Files"の横にあるボックスのチェックを外しま
す。"Next"をクリックします。 
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図 2.2 New Project ウィンドウ 4 

 
ステップ 2.10 タイトルバーに"New Project-8/10..." と表示されるウィンドウ（図 2.3）が出るまで"Next"

をクリックします。"RX600 Segger J-Link"の横にあるボックスをチェックして、"Finish"
をクリックします。  

 
図 2.3 デバッガの選択 

 
ステップ 2.11 Summaryウィンドウで"OK"をクリックします。 

ステップ 2.12 次に、Explorerウィンドウから、このアプリケーションノートの内容を抽出したフォルダ
の下にある'Source/RPDL_RX62N'フォルダに移動します。 

ステップ 2.13 ファイル Copy_RPDL_RX62N.batをダブルクリックします。コマンドウィンドウが開きま
す。 
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ステップ 2.14 デバイスを選択するように求められた場合は、LQFP100ピンに対応する番号を使用して、
"Enter"を押します。 

ステップ 2.15 RPDLをインストールする場所を尋ねられた場合は、
"C:¥Workspace¥RX_RPDL_Demo¥RX_RPDL_Demo"と入力し"Enter"を押します。RPDL
ファイルがコピーされ、終了すると、ウィンドウは図 2.4のようになります。いずれかの
キーを押して、コマンドウィンドウを閉じます。 

 
図 2.4 ワークスペースへの RPDLのコピー 

 

 

このバッチファイルにより、適合する RPDLライブラリと必要な Cソースおよびヘッダファイルが 
ワークスペースにコピーされます。必要に応じて手動でファイルをコピーすることもできます｡ 

 
ステップ 2.16 ディレクトリ"C:¥Workspace¥RX_RPDL_Demo¥RX_RPDL_Demo"を参照して、"RPDL"とい

うフォルダがあることを確認します。このフォルダがない場合は、ステップ 2.15を繰り
返し、正しいインストールパスを入力します。 

ステップ 2.17 HEWワークスペースに戻り、Build ⇒ RX Standard Toolchainの順にクリックします。 

ステップ 2.18 "C/C++"タブを選択して、"Show entries for"ドロップダウンを"Include file directories"に変更
します。 

ステップ 2.19 "Add"ボタンをクリックします。 

ステップ 2.20 表示されるウィンドウで、"Relative to"ドロップダウンを"Project directory"に変更して、
"Sub-Directory"欄に"RPDL"を入力します。ウィンドウは図 2.5のようになります。"OK"
をクリックします。 

 
図 2.5 RPDLフォルダのインクルード 
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ステップ 2.21 同じ手順で別のディレクトリを追加します。今回は"Sub-Directory"欄に"."を入力します。
（「ピリオド」1個は「カレントディレクトリ」を意味し、プロジェクトディレクトリに
なります。） 

 
図 2.6 プロジェクトのルートフォルダのインクルード 

 
ステップ 2.22 ウィンドウの上部の"Link/Library"タブをクリックします。 

ステップ 2.23 "Category"ドロップダウンで"Input"が選択され、"Show entries for"で"Library files"が選択さ
れていることを確認します。 

ステップ 2.24 "Add"ボタンをクリックします。 

ステップ 2.25 "Relative to"ドロップダウンを"Project directory"に変更します。 

ステップ 2.26 "File path"欄に"RPDL¥RX62N_library.lib"を入力し、"OK"をクリックします。 

ステップ 2.27 "OK"をクリックして、RX Standard Toolchainを終了します。 

ステップ 2.28 Project ⇒ Add Filesの順にクリックします。表示されるウィンドウで、"Files of type"ドロッ
プダウンから"C source file"を選択します。 

ステップ 2.29 プロジェクトフォルダの下の"RPDL"フォルダに移動し、Interrupt_EXDMAC.cを除くすべ
ての Cソースファイル（*.c）を選択し強調表示させます。100ピンおよび 85ピンの RX62N
製品は EXDMAコントローラをサポートしていないので、Interrupt_EXDMAC.cは含まれ
ていません。ファイルを選択し強調表示させた後、"Add"をクリックします。 

 
図 2.7 プロジェクトへの RPDLファイルの追加 
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RPDL C ソースファイルを追加した後、プロジェクトペインが見にくくなることがあります。ファイルを整
理するには、フォルダを作成して、そのフォルダに格納します。"C source file"フォルダを右クリックして、
"Add Folder"を選択します。フォルダ名に"RPDL"を入力し、'OK'をクリックします。RPDLファイルを新しい
フォルダにドラッグアンドドロップすることができます。'RPDL'ファイルは"Interrupt_"で始まるので、 
簡単に見つけることができます。完了すると、プロジェクトペインは以下のようになります。 

 

図 2.8 RPDLフォルダの作成 

 

ステップ 2.30 RPDLはデバイス割り込みを処理するので、RX "Application"プロジェクトで自動的に生成
される intprg.cおよび vecttbl.cファイルと競合します。プロジェクトナビゲーションペイ
ンでこれらのファイルを選択し強調表示させたまま、右クリックして"Exclude Build ..."を
選択して、両方のファイルを除外します。 

 
図 2.9 ベクタ処理ファイルの除外 

 
ステップ 2.31 RPDLがプロジェクトに追加され、ビルドすることができます。Build Allボタン  を押

すか、Build ⇒ Build Allの順に選択します。 

 

 

プロジェクトをビルドするときに、'L1100 (W) Cannot find "PIntPRG" specified in option "start"'という警告が
表示されます。これは'intprg.c'ファイルを以前に除外したためです。RPDLが割り込みを処理するので、この
警告は無視して問題ありません。また、toolchainメニューに進み、'PIntPRG'セクション名を削除することに
より警告を削除することもできます。Build ⇒ RX Standard Toolchainの順に選択し、"Link/Library"タブに切
り換え、"Category"を"Section"に変更することにより、プロジェクトのセクションを 
表示することができます。 



RX600シリーズ RPDLおよび PDGの使い方 

R01AN0615JU0100  Rev.1.00  Page 8 of 22 
2011.09.27  

3. ルネサス周辺ドライバライブラリ（RPDL）の使い方 
本章では RPDLの使い方を説明します。ユーザは ADコンバータを起動するためのタイマを作成します。

AD変換完了後、その値が LCDに表示されます。 

 

手順： 
ステップ 3.1 このアプリケーションノートの内容を解凍したフォルダの下にある"Source"ディレクトリ

に進みます。 

ステップ 3.2 以下のファイルを"Source"ディレクトリから HEWワークスペースプロジェクトディレク
トリ（"C:¥Workspace¥RX_RPDL_Demo¥RX_RPDL_Demo"）にコピーします。 

• glyph_api.h 
• Glyphlib_v2.lib 
• lcd.c 
• lcd.h 
• lcd_utilities.c 
• lcd_utilities.h 
• YRDKRX62N.h 
• YRDKRX62N_RSPI_API.c 
• YRDKRX62N_RSPI_API.h 

 
ステップ 3.3 第 2章で行ったとおり、Project ⇒ Add Filesの順に選択して、ファイル lcd.c、lcd_utilities.c、

YRDKRX62N_RSPI_API.cおよび Glyphlib_v2.libをカレントプロジェクトに追加します。 

ステップ 3.4 HEWでファイル RX_RPDL_Demo.cを開きます。 

 

 

RPDL ライブラリをプロジェクトに含めましたが、RPDL 関数と定義を使用するために適切なヘッダファイ
ルも含める必要があります。使用するすべての RPDLソースファイルには、使用する 2種類のヘッダファイ
ルがあります。 

1. r_pdl_definitions.h 

 a.  このファイルにはデバイス固有の定義が含まれています。 

 

2.  r_pdl_*PERIPHERAL*.h 

 a.  これらのファイルにはドライバ関数プロトタイプが含まれます。 

 b.  例：r_pdl_adc_10.h、r_pdl_cmt.h、r_pdl_tmr.hなど 

 

ドライバ関数プロトコルを宣言するヘッダは、常に r_pdl_definitions.hファイルの前のソースファイルに含ま
れます。 
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ステップ 3.5 このデモでは 10ビットADCと 8ビットタイマを一緒に使用します。また、システムクロッ
クを設定するためにクロック発生回路（CGC）も使用します。適合するヘッダファイルを
RX_RPDL_Demo.cの先頭に置きます。 

#include "r_pdl_tmr.h" 
#include "r_pdl_adc_10.h" 
#include "r_pdl_cgc.h" 
 
ステップ 3.6 これらのインクルードステートメントの後に、ファイル r_pdl_definitions.hのインクルード

を追加します。 

#include "r_pdl_definitions.h" 
 
ステップ 3.7 AD変換値を LCDに表示するのに必要なすべての基本的なハードウェアサポートを取得

するために、lcd_utilities.hにある関数 UpdateLCD()を使用します。RSPI APIライブラリに
より、LCDが常駐する RSPIバスへの共用アクセスが可能になります。これらのファイル
を前のインクルードステートメントの後に置きます。 

/* RSPI API library support */ 
#include "YRDKRX62N_RSPI_API.h" 
 
#include "lcd_utilities.h" 
#include "lcd.h" 
 
ステップ 3.8 第 1章で説明した PDGのインストールをまだ実行していない場合は、ここでインストー

ルしてください。 

ステップ 3.9 RPDL APIの使用を開始する準備ができました。PDGインストールディレクトリに格納さ
れている RPDLユーザーズマニュアル
'C:¥Renesas¥PDG2¥manuals¥r20ut0084ee0103_RX62N.pdf'を開きます。 

 

 

RPDLユーザーズマニュアルに簡単にアクセスするための便利な方法は、それを HEWプロジェクトに追加す
ることです。ソースファイルを追加する場合と同じように追加することができます。"Files of type"ドロップ
ダウンが"All Files"に選択されていることを確認してください。選択されていない場合は、ファイルは表示さ
れません。ファイルを追加した後、ファイル名がプロジェクトナビゲーションペインに表示され、そのファ

イルをダブルクリックすると PDFファイルが開きます。 

 
ステップ 3.10 RPDLを使用するために最初にすべきことは、システムクロックの設定です。その他の周

辺機能をセットアップするときにクロック設定が必要なので、システムクロックの設定が
必要となります。RPDLユーザーズマニュアルの第 4章「ライブラリリファレンス」を参
照してください。また、4.2.1項の「クロック発生回路」も参照してください。 

ステップ 3.11 リストされている最初の関数は R_CGC_Set()です。少し時間を使って APIの説明を読み、
セットアップする方法を確認してください。 

ステップ 3.12 RX_RPDL_Demo.c内の main()関数を確認し、RPDL関数呼び出しを追加して、以下のパラ
メータを使用してシステムクロックを設定します。 

• 入力周波数 12MHz 
• システムクロック = 96MHz 
• 周辺モジュールクロック = 48MHz 
• 外部バスクロック = 24MHz 
• BCLK出力を無効にする 
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ステップ 3.13 RPDLユーザーズマニュアルのとおり、以下のコードで設定が実行されます。 

/* Setup system clocks */ 
R_CGC_Set( 12E6, 96E6, 48E6, 24E6, PDL_CGC_BCLK_DISABLE ); 
 
ステップ 3.14 次に 10ビット ADCのセットアップを行います。RPDLユーザーズマニュアルの 4.2.25項

を参照してください。 

ステップ 3.15 GPIO初期化後、関数呼び出しをR_ADC_10_Create( )に追加して、以下の値を使用してADC
を作成します。 

• ユニット 1 
• チャネル AN4 
• シングルモード 
• TMR0で起動 
• 右揃え（LSB詰め） 
• 48MHz変換クロック 
• サンプリング時間 0.6us（ハードウェアマニュアルでは、最小値は 0.5usと記載） 
• 変換が終了したら関数 ADC_Callback()を呼び出す。 
• IPL 4を使用する。 

 
ステップ 3.16 RPDLユーザーズマニュアルのとおり、以下のコードで設定が実行されます。 

/* Setup 10bit ADC */ 
    R_ADC_10_Create(1, 
                    PDL_ADC_10_CHANNELS_OPTION_1 | 
                    PDL_ADC_10_MODE_SINGLE |                    
                    PDL_ADC_10_TRIGGER_TMR0_CM_A, 
                    48E6, 
                    6E-7, 
                    ADC_Callback, 
                    4 ); 

 
ステップ 3.17 AD変換を起動するための8ビットタイマを設定します。使用可能なAPI関数については、

4.2.15項を参照してください。ここから R_TMR_CreatePeriodic()関数の説明を見つけてく
ださい。 

ステップ 3.18 R_ADC_10_Create()関数呼び出し後に、関数呼び出しを R_TMR_CreatePeriodic()に追加し
て、以下の値を使用して ADCをセットアップします。 

• ユニット 0（TMR0と TMR1をカスケード接続として 16ビットカウンタを作成します。） 
• 周波数を 4Hzに設定します。 
• ADコンバータを起動します。 
• 50%デューティサイクル 
• コールバック関数なし 
• コールバックがないので IPLは 0とする。 
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ステップ 3.19 RPDLユーザーズマニュアルのとおり、以下のコードで設定が実行されます。 

/* Setup TMR */                                      
R_TMR_CreatePeriodic( PDL_TMR_UNIT0, 
                      PDL_TMR_FREQUENCY | PDL_TMR_ADC_TRIGGER_ON,         
                    4, 
                       0.5, 
                       PDL_NO_FUNC, 
                      PDL_NO_FUNC, 
                      0 ); 
 
ステップ 3.20 使用する最後の初期化コードは、LCDの設定です。これらの関数は lcd_utilities.cファイル

に収められています。R_TMR_CreatePeriodic()への関数呼び出しの後、関数呼び出しを
YRDKRX62N_RSPI_INIT()および InitializeLCD()に追加します。また、実行により main()
関数が終了しないように、この呼び出しの後に無限ループを追加します。 

/* Initialise the LCD display on RSPI bus */ 
YRDKRX62N_RSPI_Init( 0 ); 
 
/* Setup LCD */ 
InitialiseLCD();                            
 
/* Infinite loop */                          
while(1); 
 
ステップ 3.21 周辺機能を初期化したら、コールバックルーチンを書き込まなければなりません。

RX_RPDL_Demo.cファイルで、以下の関数を作成します。 

/* Callback function when ADC conversion has finished */ 
void ADC_Callback(void) 
{ 
    uint16_t ADC_value; 
      
    /* Read ADC value */ 
    //Fill in this line 
     
    /* Update ADC value on LCD */ 
    UpdateLCD(ADC_value); 
} 
 
ステップ 3.22 RPDLユーザーズマニュアルの「4.2.25 10ビットADC」を参照して、関数 R_ADC_10_Read()

を見つけます。この関数を使用して AD変換値を読み出す必要があるコード内の位置を埋
め込みます。R_ADC_10_Read()はデータを格納する位置にポインタを置くことに注意して
ください。Cプログラミング言語では、変数名の前に'&'を置くことにより、その変数のア
ドレスを取得します。コードからわかるように、'ADC_value'変数は ADC読み取り値を保
持するようにすでにセットアップされています。どの ADCユニットを使用しているかに
ついては、ステップ 3.15を参照してください。 

ステップ 3.23 RPDL呼び出しを追加した後、ADC_Callback()関数の関数プロトタイプを#includeの下の
RX_RPDL_Demo.cファイルの上部に追加します。 

void ADC_Callback(void); 
 
ステップ 3.24 Buildボタン  を押すか、ショートカット F7を使用します。 

ステップ 3.25 付属の USBケーブルを使用して YRDKRX62Nボードをワークステーションに接続します。
"J-Link USB"というラベルの付いたボード上の USBヘッダを使用してください。 
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ステップ 3.26 セッションを"DefaultSession"から"SessionRX600_Segger_J-Link"に変更します。現在のデ
バッグセッションを保存するように求めるウィンドウがポップアップした場合は、"Yes"
をクリックします。 

 
図 3.1 デバッグセッションの変更 

 
ステップ 3.27 接続ウィンドウが自動的に表示されない場合は、Connectionボタン  をクリックするか、

Debug ⇒ Connectの順に選択します。 

ステップ 3.28 ウィンドウを図 3.2と同じ構成内容にして、接続が終了するまで OKを押します。JTAG
クロックを指定するように求めるウィンドウが表示された場合は、16.5MHzを選択します。
ファームウェアをアップグレードするように求めるウィンドウが表示された場合は、
"OK"を選択します。ファームウェアのアップグレードが終了したら、USBケーブルを
YRDKから外してから、もう一度接続します。ここでステップ 3.27に従ってボードを再
び接続します。 

      
 

図 3.2 RSKへの接続 
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ステップ 3.29 プロジェクトナビゲーション画面で RX_RPDL_Demo.absファイルの"Download"をダブル
クリックするか、右クリックしてコードをボードにダウンロードします。 

 
図 3.3 コードのダウンロード 

 
ステップ 3.30 "Reset-Go"ボタン  をクリックするか、Debug ⇒ Reset Goの順にクリックします。 

ステップ 3.31 AD変換値がボードの LCDに表示されることを確認します。ポテンショメータを回した場
合、値が自動的に更新されることを確認します。 

ステップ 3.32 MCU実行を停止し、接続を解除し、HEWを閉じます。 
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4. Peripheral Driver Generator（PDG）の使い方 
本章では、ここまで RPDLで手動でコーディングしたものと同じコードを PDGを用いて設定します。PDG
は前のデモで手動でコーディングした RPDL呼び出しを含むコードを生成します。 

 

手順： 
ステップ 4.1 PDGの使い方の実例を開始する前に、最初に HEWターゲットサーバが登録されているこ

とを確認してください。HEWを起動して、Tools ⇒ Administrationの順に選択します。
Extension Componentsフォルダを開いて、"HewTargetServer"が表示されていることを確認
します。 

 
図 4.1 HTSレジストリの検証 

 

ステップ 4.2 表示されていない場合は、"Search disk..."をクリックして、"Start"をクリックします。検索
が終了したら、リストから"HewTargetServer"を選択して、"Register"をクリックします。完
了したら、HEWを閉じます。 



RX600シリーズ RPDLおよび PDGの使い方 

R01AN0615JU0100  Rev.1.00  Page 15 of 22 
2011.09.27  

 
図 4.2 レジストリへの HTSの追加 

 
ステップ 4.3 Start ⇒ All Programs ⇒ Renesas ⇒ Peripheral Driver Generator 2の順に選択して PDGを起動

します。 

 
図 4.3 PDGアプリケーション 

 
ステップ 4.4 File ⇒ New Projectの順に選択して新しい PDGプロジェクトを起動します。以下のウィン

ドウが表示されます。 
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図 4.4 PDG新規プロジェクトウィンドウ 

 
ステップ 4.5 ウィンドウを図 4.4と同じ構成内容にして、"OK"をクリックします。 

 

PDGプロジェクトは HEWプロジェクトから分離されているので、同じディレクトリに格納する必要はあり
ません。 

 
ステップ 4.6 RX周辺機能を制御するウィンドウが表示されます。編集ペインの下部にあるタブを使用

して、現在編集中の周辺機能を切り換えることができます。デフォルトでは、選択された
最初のペインは、システムクロックを制御する"SYSTEM"です。上記と同じように、以下
のパラメータでクロックをセットアップします。 

• EXTAL端子の入力周波数 12MHz 
• システムクロック = 96MHz 
• 周辺モジュールクロック = 48MHz 
• 外部バスクロック = 24MHz 
• 専用 USBクロック = 48Mhz 
• BCLK出力を無効にする 

 

 

仮に PCLKを 96MHzに設定してみます。PDGはこの設定が不可であることを示す赤色のエラーマークを表
示します。エラーマークにマウスを移動すると、エラーの原因と有効な設定値が表示されます。また、周辺

機能にエラーがあるたびに、PDGは周辺機能タブに赤色のエラーマークを表示します。 
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ステップ 4.7 次に、'ADa'タブに切り換え、RPDLと同じように以下の設定で AD1を設定します。終了
すると、ウィンドウは図 4.5のようになります。 

• ユニット 1（AD1） 
• チャネル AN4 
• シングルモード 
• LSB詰め 
• TMR0コンペアマッチで起動 
• 48MHz変換クロック 
• サンプリング時間 0.6us（ハードウェアマニュアルでは、最小値は 0.5usと記載） 
• 変換が終了したら関数 ADC_Callback()を呼び出す。 
• IPL 4を使用する。 

 

 
図 4.5 PDGによる AD1の構成 
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ステップ 4.8 TMRタブに切り換え、以下の設定で構成します。 

• ユニット 0（TMR0と TMR1をカスケード接続し 16ビットカウンタとします。） 
• 8192分周した PCKLを使用する。 
• 周波数を 4Hzに設定する（250ms周期） 
• コンペアマッチ Aをクリアする。 
• ADコンバータを起動 
• 50%デューティサイクル 
• コールバック関数なし 

 

 
図 4.6 PDGによる 8ビットタイマの構成 

 

 

TMRペインの下部にあるボックスをチェックして必ず ADCトリガを有効にしてください。 

 

 
ステップ 4.9 File ⇒ Saveの順に選択してプロジェクトを保存します。 

ステップ 4.10 HEWを開き、第 2章と同様に新しいワークスペースを作成します。ただし、今回は
"RX_PDG_Demo"という名前にして、HEWがワークスペースを作成した後に RPDLを追加
しません（ステップ 2.1～2.11を繰り返します）。 
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ステップ 4.11 第 3章の始めに行ったように以下のファイルをプロジェクトにコピーします。 

• glyph_api.h 
• Glyphlib_v2.lib 
• lcd.c 
• lcd.h 
• lcd_utilities.c 
• lcd_utilities.h 
• YRDKRX62N.h 
• YRDKRX62N_RSPI_API.c 
• YRDKRX62N_RSPI_API.h 

 
ステップ 4.12 ファイル lcd.c、lcd_utilities.c、YRDKRX62N_RSPI_API.cおよび Glyphlib_v2.libをカレント

プロジェクトに追加します。 

ステップ 4.13 コードを生成して、HEWに登録することができます。HEWで手動でファイルを登録する
ことができますが、PDGは HEWターゲットサーバを使用してこのサービスを自動的に実
行します。最初にすることは、ソースファイルを生成することです。PDGで、Tool ⇒ 
Generate source filesの順に選択します。正常に完了したことを示すウィンドウが表示され
ます。"OK"をクリックして、閉じます。 

 

 

PDGを使用してソースファイルを生成する場合は、PDGプロジェクトフォルダの下に格納されます。HEW
で登録した後でも、移動されません。これは、複数のプロジェクトでソースファイルを使用している場合、

常に最新のファイルを保持することができるので便利です。 

 
ステップ 4.14 次のステップでは、生成されたファイルと RPDLを HEWプロジェクトに登録します。登

録するには、Tool ⇒ Register source files in HEW projectの順にクリックします。 

ステップ 4.15 任意のワークスペースが開いたことを確認するウィンドウが表示されます。"OK"をク
リックします。 

ステップ 4.16 ライブラリをリンクする順序を設定することを求めるウィンドウが表示されます。このデ
モでは 1つのライブラリのみを使用しているので、順序を設定する必要はありません。
"OK"をクリックします。 

ステップ 4.17 ファイルが正しく登録されたことを示すウィンドウが表示されます。"OK"をクリックし
て、閉じます。 

ステップ 4.18 HEWに戻り、以下のように変更されていることを確認します。 

• PDGからの生成されたファイルを含む新しいフォルダ"AddFromPDG"があります。 
• ファイル intprg.cおよび vecttbl.cは自動的に除外されています（以前のプロジェクトでは、これは
手動で実行しなければなりませんでした）。 

• ツールチェーンオプションウィンドウの Link/Libraryタブを見ると、RPDLライブラリが登録され
ていることがわかります。（PDGでは、このMCUの RPDLライブラリの名前は
RX62N_library_LQFP_100.libとなっています。） 

 
ステップ 4.19 ファイル YRDKRX62N_RSPI_API.cに RPDL関数呼び出しを使用するには、"include"ディ

レクトリを追加する必要があります。Build ⇒ RX Standard Toolchainの順に選択します。 

ステップ 4.20 "C/C++"タブが選択されていることを確認し、"Show entries for"ドロップダウンを"Include 
file directories"に変更します。 

ステップ 4.21 "Add"をクリックします。表示されるウィンドウで、"Relative to"ドロップダウンを"Custom 
directory"に変更します。 
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ステップ 4.22 "Browse"をクリックして、"C:¥Renesas¥PDG2¥source¥RX¥RX62N¥i_src"および click "Select"
に移動します。"OK"をクリックします。 

ステップ 4.23 "Show entries for"ドロップダウンを"Defines"に変更します。 

ステップ 4.24 "Add"ボタンをクリックします。表示されるウィンドウで、"Macro"エントリに
"DEVICE_PACKAGE_LQFP_100"を入力し、"Replacement"エントリには何も入力しません。
"OK"をクリックします。 

 

 

"i_src"パスを追加し、DEVICE_PACKAGE_LQFP_100 defineを追加した理由は、YRDKRX62N_RSPI_API.c
ソースファイル内で RPDL関数呼び出しを使用することができるようにするためです。以前と同じようにプ
ロジェクトに RPDLに追加することもできますが、共通 RPDLライブラリを保持するためにこの方法を使用
しました。PDGファイルは PDGディレクトリの RPDLライブラリを使用するので、そのディレクトリも使
用しました。使用している MCUを選択するために#defineを使用しました。以前はコマンドプロンプトでど
のMCUを使用しているかを尋ねられたときにRPDLバッチでこれを処理していました。PDGの外部でRPDL
を使用していない場合は、これらのステップは必要ありません。 

 
ステップ 4.25 HEWプロジェクトに戻るまで"OK"をクリックします。 

ステップ 4.26 PDGによって生成された関数を使用するには、プロジェクトと関連するヘッダファイル
を含めなければなりません。RX_PDG_Demo.cを開き、ファイルの先頭にヘッダファイル
r_pg_rx_pdg_demo_setup.hを含めます。これを実行しているときに、LCDにアクセスする
ために以前に使用したプロジェクトのヘッダファイルも含めます。 

#include "r_pg_rx_pdg_demo_setup.h"  
 
/* RSPI API library support */ 
#include "YRDKRX62N_RSPI_API.h" 
#include "lcd_utilities.h" 
#include "lcd.h" 
 

 

PDG ファイルを識別しやすくするために、生成されるすべてのファイルは'R_PG'で始まります。ADC チャ
ネル 1に対して PDGが生成したコードを見つけるには、ファイル'R_PG_ADC_10_AD1.c'を探してください。 

 
ステップ 4.27 ここで、PDGが生成した関数を呼び出すことができます。これらの関数名を理解するの

に最も簡単な方法は、関連するヘッダファイルを開くことです。RPDLプロジェクトで実
行したのと同じセットアップ手順に従って、最初にシステムクロックをセットアップしま
す。ヘッダファイル R_PG_Clock.hを開きます。 

ステップ 4.28 3つの関数があり、その 1つは R_PG_Clock_Set()という名前が付けられています。その他
の関数（R_PG_Clock_Start_SUB()および R_PG_Clock_Stop_SUB()）もありますが、その他
の関数がサブクロックと関連することを識別するのは簡単です。RX_PDG_Demo.c内の
main()関数呼び出しを探して、関数を call to R_PG_Clock_Set()に追加します。 

ステップ 4.29 ファイル R_PG_Clock.cを開き、関数 R_PG_Clock_Set()を見つけます。以前に第 2章で作
成した同じ RPDL呼び出しを使用していることを確認します。 

ステップ 4.30 引き続き PDG関数を使用してプロジェクトをビルドし、ADCと TMRをセットアップし
ます。 
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ステップ 4.31 PDG関数の後に関数呼び出しを追加して、YRDKRX62N_RSPI_Init()および InitialiseLCD()
関数呼び出しを使用して RSPIバスと LCDを初期化します。また、main()関数の終わりに
無限ループを追加します。 

void main(void) 
{ 
    R_PG_Clock_Set(); 
     
    R_PG_ADC_10_Set_AD1(); 
    R_PG_Timer_Start_TMR_U0(); 
     
    /* Initialise the LCD display on RSPI bus */ 
    YRDKRX62N_RSPI_Init( 0 ); 
 
    /* Setup LCD */ 
    InitialiseLCD(); 
     
    while(1); 
} 
 
ステップ 4.32 ステップ 3.21で使用された ADC_Callback()関数をコピーし、RX_PDG_Demo.cに追加しま

す。 

ステップ 4.33 今回は R_ADC_10_Read() RPDL関数を使用する代わりに、R_PG_ADC_10_AD1.hにある
R_PG_ADC_10_GetResult_AD1() PDG関数を使用します。 

ステップ 4.34 Buildボタン  をクリックするか、Build ⇒ Build Allの順に選択します。 

ステップ 4.35 第 3章の手順に従ってデバッグセッションを変更し、ボードに接続します。 

ステップ 4.36 MCUにコードをダウンロードして、Reset-Go  をクリックするか、Debug ⇒ Reset Go
の順にクリックします。 

ステップ 4.37 コードが第 3章と同じように実行されることを確認します。 
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製品ご使用上の注意事項 

ここでは、マイコン製品全体に適用する「使用上の注意事項」について説明します。個別の使用上の注意

事項については、本ドキュメントおよびテクニカルアップデートを参照してください。 

 

1. 未使用端子の処理 

【注意】未使用端子は、本文の「未使用端子の処理」に従って処理してください。 

CMOS 製品の入力端子のインピーダンスは、一般に、ハイインピーダンスとなっています。未使用

端子を開放状態で動作させると、誘導現象により、LSI 周辺のノイズが印加され、LSI 内部で貫通電

流が流れたり、入力信号と認識されて誤動作を起こす恐れがあります。未使用端子は、本文「未使用

端子の処理」で説明する指示に従い処理してください。 

2. 電源投入時の処置 

【注意】電源投入時は，製品の状態は不定です。 

電源投入時には、LSI の内部回路の状態は不確定であり、レジスタの設定や各端子の状態は不定で

す。 

外部リセット端子でリセットする製品の場合、電源投入からリセットが有効になるまでの期間、端子

の状態は保証できません。 

同様に、内蔵パワーオンリセット機能を使用してリセットする製品の場合、電源投入からリセットの

かかる一定電圧に達するまでの期間、端子の状態は保証できません。 

3. リザーブアドレス（予約領域）のアクセス禁止 

【注意】リザーブアドレス（予約領域）のアクセスを禁止します。 

アドレス領域には、将来の機能拡張用に割り付けられているリザーブアドレス（予約領域）がありま

す。これらのアドレスをアクセスしたときの動作については、保証できませんので、アクセスしない

ようにしてください。 

4. クロックについて 

【注意】リセット時は、クロックが安定した後、リセットを解除してください。 

プログラム実行中のクロック切り替え時は、切り替え先クロックが安定した後に切り替えてくださ

い。 

リセット時、外部発振子（または外部発振回路）を用いたクロックで動作を開始するシステムでは、

クロックが十分安定した後、リセットを解除してください。また、プログラムの途中で外部発振子

（または外部発振回路）を用いたクロックに切り替える場合は、切り替え先のクロックが十分安定し

てから切り替えてください。 

5. 製品間の相違について 

【注意】型名の異なる製品に変更する場合は、製品型名ごとにシステム評価試験を実施してくださ

い。 

同じグループのマイコンでも型名が違うと、内部 ROM、レイアウトパターンの相違などにより、電

気的特性の範囲で、特性値、動作マージン、ノイズ耐量、ノイズ輻射量などが異なる場合がありま

す。型名が違う製品に変更する場合は、個々の製品ごとにシステム評価試験を実施してください。 
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